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DocXpress Markup 
Markup within the template document is identified by color-coded12 Microsoft Word content controls (henceforth referred to informally as “lozenges”): 

 
A (formatted) text value that is inserted into the assembled document

 

 
Conditional content that is only included in the assembled document if the condition holds

 

 
Repetitious content that is included zero or more times in the assembled document

 

 
Content that is assembled as a separate attachment document

 

 
Apply punctuation to the content within

 

 
The point where the punctuation mark is inserted

 

 
The name of a clause (paragraph)

 

 
A cross-reference to a named clause

 

 
Risk figures which are aggregated together

 

 
A risk factor which is applied to the aggregated risk figures

 

 

1 The colors of markup elements can be changed using the button in the Options group. 
2 A content control lozenge generally has a solid background when it occurs within a paragraph, and a white background when it spans one or more paragraphs. 



D o c X p r e s s  A u t h o r  M a n u a l  P a g e  | 3 

 

DocXpress Author Manual 
Table of Contents 

1 Questionnaire .......................................................................................................................................................................................................................... 5 

1.1 Launch .............................................................................................................................................................................................................................. 5 

1.2 Layout ............................................................................................................................................................................................................................... 5 

1.3 Default Locale .................................................................................................................................................................................................................. 6 

1.4 Using Locales .................................................................................................................................................................................................................... 6 

2 Markup ..................................................................................................................................................................................................................................... 7 

2.1 Edit ................................................................................................................................................................................................................................... 8 

2.2 Insert ................................................................................................................................................................................................................................ 9 

2.3 Delete ............................................................................................................................................................................................................................... 9 

2.4 Go To ................................................................................................................................................................................................................................ 9 

2.5 Walk To ............................................................................................................................................................................................................................ 9 

2.6 Go Back ............................................................................................................................................................................................................................ 9 

3 Dictionary ............................................................................................................................................................................................................................... 10 

3.1 Add ................................................................................................................................................................................................................................. 11 

3.2 Insert .............................................................................................................................................................................................................................. 11 

3.3 Go To .............................................................................................................................................................................................................................. 12 

3.4 Go Back .......................................................................................................................................................................................................................... 12 

4 Help ........................................................................................................................................................................................................................................ 13 

4.1 Examples ........................................................................................................................................................................................................................ 13 

4.2 Columns ......................................................................................................................................................................................................................... 13 



D o c X p r e s s  A u t h o r  M a n u a l  P a g e  | 4 

 

4.3 Types .............................................................................................................................................................................................................................. 13 

4.4 Operators ....................................................................................................................................................................................................................... 13 

4.5 Functions ........................................................................................................................................................................................................................ 13 

5 Options ................................................................................................................................................................................................................................... 14 

5.1 Color ............................................................................................................................................................................................................................... 14 

5.2 DOCX, DOC, PDF ............................................................................................................................................................................................................. 14 

5.3 Auto Save ....................................................................................................................................................................................................................... 14 

5.4 Author Note ................................................................................................................................................................................................................... 14 

5.5 Menu Size ....................................................................................................................................................................................................................... 15 

6 Foreign ................................................................................................................................................................................................................................... 16 

6.1 Contract Express ............................................................................................................................................................................................................ 16 

6.2 Import Responses .............................................................................................................................................................. Error! Bookmark not defined. 

 

 



D o c X p r e s s  A u t h o r  M a n u a l  P a g e  | 5 

 

1 Questionnaire 

The questionnaire group supports the launching of an in-situ questionnaire and the generation of instance documents3 based upon the template wording 

and the answers given. 

Launch Launch an in-situ questionnaire 

Layout Choose the layout of the questionnaire 

Default Locale Choose the default locale of the questionnaire 

Using Locales Choose any other locales referenced in the template 

1.1 Launch 

Launch a questionnaire in the chosen layout and with the chosen default locale and any other using locales. 

1.2 Layout 

Choose the layout in which the questionnaire is launched. 

The built-in layouts are: 

• Standard The layout is divided into 3 columns containing the sections, the questions for the current section, and the document wording 

• Tablet The layout is divided into 2 columns containing the sections with in-situ questions for the current section, and the document wording 

• Mobile The layout is a single column containing the sections with in-situ questions for the current section 

The layout can be overridden (baked into the template itself) by adding a Dictionary > Add > Configuration > Layout table to the dictionary. 

 
3 The file type of the generated documents is determined by the chosen file type in the Options group. 
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1.3 Default Locale 

Choose the default locale for the questionnaire. 

The built-in locales are: 

• English (United States) 

• English (United Kingdom) 

• German (Germany) 

• Spanish (Spain) 

• French (France) 

The default locale can be overridden (baked into the template itself) by adding a Dictionary > Add > Configuration > Locale table to the dictionary. 

1.4 Using Locales 

Choose one or more other locales that are referenced in the template. 
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2 Markup 

The markup group supports the creation and management of markup within the template wording. 

Edit Edit the selected markup 

Insert Insert a new markup 

Delete Delete the selected markup 

Go To Go to some markup chosen by its type and label 

Walk To Go to some markup relative to the current selection 

Go Back Go back to the previous selection 
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2.1 Edit4 

The editor pops up for the selected markup. 
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2.2 Insert 

Insert a new markup at the current selection point5. 

Value, Punctuation Mark, Clause Label, Clause Reference, Risk Figure and Risk Factor markups occupy a singleton point in the template document. 

Conditional, Repeat By, Punctuation, and Attach markups occupy a range in the template document. 

2.3 Delete 

Remove a Conditional, Repeat By, Punctuation, or Attach markup without destroying its content. 

2.4 Go To 

Select a markup by its type (Value, Repeat By, etc.) and its label (e.g. Agreement date, For each other party, etc.). 

Alternatively, select a markup that contains a named variable, computation, or literal value. 

Note that if there are multiple occurrences in the template document then the next occurrence is selected. 

2.5 Walk To 

Select a markup relative (parent, first child, next sibling, etc.) to the current selection. 

2.6 Go Back 

Go back to the previously selected markup. 

 
4 The Edit button can also be used to change the name of a searchable table. 
5 Subject to Microsoft Word rules on the positioning of Content Controls. 
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3 Dictionary 

The dictionary group supports the creation and management of the dictionary. 

Add Add a new table to the dictionary 

Insert Insert a textual value into a table cell 

Go To Go to the definition of a dictionary component 

Go Back Go back to the previous selection 

Rename Rename a dictionary component 

Unlike most other authoring environments the dictionary (or its equivalent) is not hidden behind a user interface, but is a series of Microsoft Word tables.  

As such, the dictionary can be read, edited, and printed just like any other part of the document. 

The components of the dictionary are identified by Microsoft Word content controls: 

 
The arrangement of (repetitious) sections and questions that form the questionnaire

 

 
Notification messages that can be raised against the answers on the questionnaire

 

 
The variables whose values are collected on the questionnaire

 

 
Named computations over the variables

 

 
Named literal values

 

 
Named formats that can be applied to values

 

 
Complex entities that have numerous properties

 

 
Static entity instances that can be chosen

 

 
Searchable tables from which cell texts can be selected (SQL-like)
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Custom functions that supplement the built-in functions

 

 
Configuration of the questionnaire that is baked-into the template

 

 
An author note that will not be included in the assembled document

 

3.1 Add 

If the dictionary content control (variables, computations, etc.) does not exist then a new content control is inserted at the end of the template document. 

Add a new table at the end of the dictionary content control. 

3.2 Insert 

Insert some textual value into a dictionary table. 

In particular, Dictionary > Insert > By Context uses the selected table cell to make suggestions. 

For example, a cell in the Input column of a Variables table will suggest the different types of input that can be used to collect a data value. 

For example, a cell in the Mode column of a Variables table will suggest the different modes for that particular type of input. 
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3.3 Go To 

Select a table row that defines a named dictionary component. 

3.4 Go Back 

Go back to the previously selected dictionary component. 
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4 Help 

The help group on the ribbon contains buttons that assist the author. 

Examples Insert examples of tables that collectively define the dictionary 

Columns The meaning of each column in the dictionary tables 

Types The types of entries in the dictionary tables 

Operators The built-in operators 

Functions The built-in functions 

4.1 Examples 

Add, at the selection point, an Author Note content control containing an example dictionary table. 

4.2 Columns 

Popup the definition of a column in a dictionary table. 

4.3 Types 

Popup the definition of a DocXpress type that is used in the dictionary. 

4.4 Operators 

Popup the definition of a built-in operator. 

4.5 Functions 

Popup the definition of a built-in function. 
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5 Options 

The options group on the ribbon contains buttons that configure the authoring environment. 

Color Change the color theme for the content control lozenges or names that occur in the dictionary 

DOCX, DOC, PDF The Microsoft Word format of the generated documents 

Auto Save Automatically save the template document, if necessary, prior to launching the questionnaire 

Author Note Add an author note column when adding new tables to the dictionary 

Menu Size Determines the maximum menu size for dictionary names before they are partitioned (A-Z) 

5.1 Color 

Change the color of the content control lozenges, or change the color of the names of dictionary components such as variables, computations, etc.. 

5.2 DOCX, DOC, PDF 

DOCX Instance documents are generated in DOCX format 

DOC Instance documents are generated in DOC format 

PDF Instance documents are generated in PDF format 

5.3 Auto Save 

Selected The document is automatically saved, if necessary, prior to launching the questionnaire 

Deselected The author is prompted to save the document, if necessary, prior to launching the questionnaire 

5.4 Author Note 

Selected An author note column is included whenever a new table is added to the dictionary 
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Deselected Author note columns are not added 

5.5  Menu Size 

This  button determines the maximum number of names in a dropdown menu beyond which the names are partitioned by their initial letter (A-Z). 
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6 Foreign 

The foreign group on the ribbon helps authors integrate foreign documents and data. 

6.1 Contract Express 

The steps taken to transform a Contract Express template into a DocXpress template are: 

Detect detect the presence of a hidden Contract Express dictionary 

Find markup fields find the locations of fields taking the form {expression} 

Transform markup fields transcribe the expressions and replace with DocXpress markup content controls 

Find markup spans find the locations of spans taking the form [expression…] 

Transform markup spans transcribe the expressions and replace with DocXpress markup content controls 

Transform dictionary transcribe the dictionary expressions and insert DocXpress dictionary content controls 

Edit transcriptions edit any expressions that were not successfully transcribed 


